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Importing Student Data into AccelTest 

If you have students in a database already, you may be able to import them into AccelTest. You can 
import students from three types of files: 

• Import from a Comma Separated Value (CSV) formatted file

• Import from a Renaissance Learning LIS product (FMD) formatted file

• Import from another AccelTest database (RBD) formatted file.

1. To import students, click on the Gradebook 
menu and click Import Students.

2. The Import Students Wizard 
(Assistant) opens.

3. Click on the type of file you are 
importing. For example, if you want to 
import students from your Accelerated 
Reader database, you would click on 
“Import from a Renaissance Learning LIS 
product.” (This imports a .FMD file).

Check the Note to ensure that you will 
not exceed your license capacity limit, 
when you import your students.

Click [Next].

4. The Import Students dialog box opens. 
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5. In the Import Students dialog box, navigate 
to the drive and folder where your 
Student.FMD file is located. 

A typical Renaissance Learning installation 
places the STUDENT.FMD file in the 
following location on your local Hard Drive or 
Network Drive: 

ALSDATA: COMMON FILES: STUDENT.FMD.

Click on STUDENT.FMD and then [Open] or 
[Select].

6. Confirm that the file and location are correct. 

Click [Next].

7. In the Select Students dialog box, you will 
select the students to import. 

To import all of the students,click on the [Add 
All] button, and then the click the [Next] 
button.

If you only want to import some of the 
students, first hold down the <Ctrl> key 
(Windows) or the <z> key (Macintosh) and 
then click on the students you want to import. 
You can also select a group of students by 
clicking on the first student name, holding 
down the <Shift> key, and clicking on the last student name. Click on the [Add] button, then the [Next] button.

Note: If you want to add your students to sections as you import them, you must import students from one 
class at a time. Select students who will be added in the same section.

Windows

Macintosh
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8. The Add Students to Section dialog box opens. 

If you want to simply add the students 
without associating them with a class 
section, select the “Do not add the 
students into a section” option.

If you have a class section you want to 
add the students to, select the “Add 
the students into an existing section” 
option, and click on the list to select 
the section.

If you want to create a new section, 
select “Add the students into a new 
section” option. Click in the box and 
type in the new section name. 

After you have made your selection, 
click [Next].

9. Review the information in the Summary dialog box. 

If it is correct, click the [Finish] button (Windows) or 
the [Done] button (Macintosh). 

If not, click the [Back] button and make corrections.
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Exporting Student and Grade Information as Text

Follow these steps to export student and grade information as a text file. You must be in the 
Gradebook to export this information. The text file is tab-delimited so you can use it in a 
spreadsheet program.

1. If you are not already in the Gradebook, open it. From the Getting Started screen, click on [Gradebook]. 

2. To export information for an assignment, click in the top of the column for the assignment. Then click in the 
Gradebook drop-down menu and click Export Results.

3. Choose the drive and folder for the export file. Type a name for your file, ending in .txt. Click [Save].

4. When the export is complete, the program will notify you. Click the [OK] button.

New Section

1. If you need to add a new class section, go to the 
Gradebook menu and click New Section.

2. In the New Section dialog box, type the name 
of the new section in the Name box. 

3. You can enroll students in your new section.
To enroll all of the students, click on the [Add All] 
button, and then the [Next] button.

If you only want to enroll some of the students, 
first hold down the <Ctrl> key (Windows) or the 
<z> key (Macintosh) and then click on the 
students you want to import. 

You can also select a group of students by clicking on the first student name, holding down the <Shift> key, 
and clicking on the last student name. Click on the [Add] button, then the [Next] button.

First: Choose the drive 
and the folder where 
you want to save the 
export file. 

Second: Type a name 
for the file.

Third: Click [Save].
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Edit Section

To edit a section (add or remove 
students) from the Gradebook 
screen, click on the All Sections 
drop-down menu and select the 
section you want to edit.

In the Gradebook drop-down 
menu, click on Edit Section.

In the Edit Section dialog box, if 
you are adding students, look in 
the Students to choose from 
column. 

If you are deleting students, look in 
the Students enrolled in column.

To add (or delete) all of the 
students, click on the [Add All] (or 
[Delete All]) button, and then 
click the [OK] button.

If you only want to add (or delete) 
some of the students, first hold 
down the <Ctrl> key (Windows) or 
the <z> key (Macintosh) and then click on the students you want to add (or delete). You can also 
select a group of students by clicking on the first student name, holding down the <Shift> key, and 
clicking on the last student name. Click on the [Add] button, then the [OK] button.
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Delete Section

To delete a section from the 
Gradebook screen, click on the All 
Sections drop-down menu and 
select the section you want to 
delete. (Students and their grades 
remain in the Gradebook after 
their section is deleted.)

In the Gradebook drop-down 
menu, click on Delete Section.

When asked if you want to delete 
the section, click [Yes].

Assignment Properties

To set assignment properties for an 
assignment, click on the column 
heading for the assignment in the 
Gradebook screen. Click on the 
Gradebook menu and click 
Assignment Properties. Refer to 
Assignment Editor Properties 
information. See page 77 for 
detailed information and 
instructions.

Remove Assignment

To remove an assignment, click on 
the column heading for the 
assignment in the Gradebook 
screen. Click on the Gradebook 
menu and click Remove 
Assignment. A warning appears 
stating student records for the 
assignment will be lost; to remove 
assignment anyway, click [Yes].
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Export Results

You can export student and grade information as text. To Export 
Results, from the Gradebook screen, click on the Gradebook drop-
down menu and click on Export Results.

For detailed instructions, see“Exporting Student and Grade 
Information as Text” on page 39.

Show Scores as Points

If you have selected show scores as percentages, to change to 
show scores as points, from the Gradebook screen, click on 
the Gradebook drop-down menu and click on Show Scores 
as Points.

Show Scores as Percentages

If you have selected show scores as points, to change to show 
scores as percentages, from the Gradebook screen, click on 
the Gradebook drop-down menu and click on Show Scores 
as Percentages.

Show Entire School Year

If you have selected show (number) term, to change to show 
entire school year, from the Gradebook screen, click on the 
Gradebook drop-down menu and click on Show Entire 
School Year.

Show Term

If you have selected show entire school year, to change to 
show (number) term, from the Gradebook screen, click on 
the Gradebook drop-down menu and click on Show (number) Term.
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Reports

You can create reports and print them in AccelTest. From the Reports drop-down menu, click on 
one of reports. You will be asked if you want to Preview or Print the report. 

You can select Preview to see what the report looks like and check its data contents before printing.

Some reports can be customized to suit your preferences. See “Setting Reports Preferences” on 
page 56. 

Report Descriptions

The table below lists the AccelTest reports. It includes a brief description of each report. There is 
additional information and a view of the reports in “Report Details” on page 46. 

Note: You must be in the Gradebook in order to select the Answer Key, Assignment Analysis, 
Assignment Results, Group Assignment, Overdue Assignments, Student Grade, or the Student 
Record Report.

Report Name Description

Answer Key Select this report from the Gradebook. This report is for teacher use and identifies 
correct answers, as well as all pertinent information for the assignment.
Preferences: Print/Preview Setting

Assignment Analysis Select this report from the Gradebook. The Assignment Analysis report provides 
assignment information, an item analysis summary, and some item details for 
assignments created in AccelTest (change if this is not implemented in software-See 
page page 46 also). The report can be used with assignments that were not created in 
AccelTest; however the report will show less information detail for each item.
Preferences: Print/Preview Setting

Assignment The Assignment report provides a list of all assignments found in the Assignment tab. 

This report helps the teacher identify assignments that can be used for lesson 
planning.
Preferences: Print/Preview Setting, Sort Order
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Assignment Results Select this report from the Gradebook. This report can provide the student with 
immediate feedback on an assignment. Teacher-selected preferences determine if 
the report should print after the student scores an assignment and if only missed or 
all questions and/or correct answers are shown. The Assignment Results report has 
space for a teacher’s signature and comments.
Preferences: Print/Preview Setting, Questions to display, Show correct answers, 
Autoprint, Batch print

Free Response Grading 
Worksheet

This is a worksheet that helps the teacher record student scores when they have 
missed points on free response items. Note: The Gradebook assumes the students 
earn all of the points on free response items. 

This worksheet provides a place for teachers to record reduced point scores for 
updating the Gradebook.

The worksheet should be printed after the student’s scan cards have been scored, as 
the scores will be shown for the scanned answers part on the assignment. This will 
help the teacher in grading the free response items.
 Preferences: Print/Preview Setting 

Gradebook Summary The Gradebook Summary Report lists each student and their grades for the term and/
or semester. The display options showing on screen (On-screen points, percentages, 
section and subject) will be printed, for example. 
Preferences: Print/Preview Setting 

Group Assignment Select this report from the Gradebook, so you can display the results for a specific 
assignment for a group of students. 

This report shows:
• average
• median
• standard deviation of points earned
• percent of points possible
• high and low score
• students with a Waiting or Overdue Status
Preferences: Print/Preview Setting, Sort Order

Overdue Assignments Select this report from the Gradebook. This report lists all incomplete assignments 
(homework, tests, quizzes, etc.) for each individual student. Gradebook scores 
overdue assignments as 0 points earned.
Preferences: Print/Preview Setting, 

Program Information This report lists specific program information including:
• how AccelTest is set up
• computer configuration and computer hardware information
• user defined preferences
Preferences: Print/Preview Setting

Report Name Description
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Report Filters

The Gradebook has a Section drop-down menu and a Subject drop-down menu that are useful for 
filtering information in the Gradebook screen. The filters save time by limiting the amount of 
information you must scroll through on the screen. The reports reflect the “as filtered” screen 
content. AccelTest resets to All Sections and All Subjects when it starts.

The Section drop-down menu allows the selection of all sections or the selection of one specific 
section.

The Subject drop-down allows the selection of all subjects, or one particular subject.

Student Grade Select this report from the Gradebook. The student grade report shows: Term and 
semester progress.
•  year-end progress
• provides space for attendance and comments
• may serve as a report card for schools that do not have a standard report card
• useful for transferring information to a standard school report card 
Preferences: Print/Preview Setting

Student Record Select this report from the Gradebook. This is an historical record of scored and 
teacher entered assignments for the 
student. The report can:
• provide the student with a record of their assignments
• be used at parent-teacher conferences
• be filed in the student’s portfolio
Preferences: Print/Preview Setting, Page break after student

Report Name Description
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Report Details

Answer Key

This report shows the teacher the correct 
answers for an assignment, as well as other 
pertinent information.

The answer key report produces an answer key 
for each variation. Each variation is identified 
by a letter code, after the Assignment ID 
number. 

Assignment Analysis

The Assignment Analysis report provides 
assignment information, an item analysis 
summary, and some item details (for 
assignments that were not created in 
AccelTest -change if report changes to reflect 
teacher created assignments. See also  page 43.
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Assignment

The Assignment report lists all of the 
assignments in the Assignment tab.

Assignment Results

The Assignment Results report can provide 
the student with immediate feedback on an 
assignment. 

The teacher selects a preference to print or not 
print the report, and whether the printout 
shows only missed or all questions and/or 
correct answers.

Space is provided for the teacher signature and 
comments.

Free Response Grading Worksheet

The Free Response Grading Worksheet report 
helps the teacher record student scores for 
missed points on free response items. Note: 
The Gradebook assumes the students earn all of 
the points on free response items. 

This worksheet provides a place for teachers to 
record reduced point scores for updating the 
Gradebook.

Print the worksheet after the student’s scan cards have been scored, as the scores are shown for the 
scanned answers part on the assignment. This helps the teacher in grading the free response items. 
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Gradebook Summary

The Gradebook Summary Report lists each 
student and their grades for the term and/or 
semester. The display options showing on 
screen (On-screen points, percentages, section 
and subject) will be printed, for example. 

Group Assignment

The Group Assignment report displays the 
results for a specific assignment for a group of 
students. The report shows:

• average

• median

• standard deviation of points earned

• percent of points possible

• high and low scores 

• students with a Waiting or Overdue status.

Overdue Assignments

This report lists all incomplete assignments 
(homework, tests, quizzes, etc.) for each 
individual student. 

Note: Gradebook scores overdue assignments 
as 0 points earned.
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Program Information.

The Program Information report shows 
specific program information, including:

• How AccelTest is set up

• Computer configuration and computer 
hardware information

• User defined preferences

Student Grade

Select this report from the Gradebook. The 
student grade report:

• shows term and semester progress

• shows year-end progress

• has space for attendance and comments

• can serve as a report card

• useful for transferring information to a 
report card.

Student Record

This report is an historical record of scored 
and teacher entered assignments for the 
student. The report can:

• provide the student with a record of their 
assignments

• be used at parent-teacher conferences

• be filed in the student’s portfolio
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Preferences

Using the AccelTest preferences, you can adjust how AccelTest works for your 
school. The table below lists the preferences in AccelTest and tells you how to 
change them. The preferences are available in the Preferences menu. 

Preference What it does How to change it

School Year Use this preference to enter your 
school year information, including start 
and end dates for the school year, 
number of terms, start and end dates 
for terms, and, if applicable, number of 
terms per semester. Changing the 
school year affects the calculation of 
student grades. Your school year 
should be completely set up before you 
start scoring student assignments. 

1. Click on the Preferences menu and 
select School Year.

2. The School Year Assistant (Wizard) 
dialog box will open. Click [Next].

3. Enter the Start and End dates for your 
school year, and click [Next].

4. Select the number of terms in your school 
year and click [Next].

5. Enter the Start and End date for each term 
and click [Next]. 

6. If your terms are grouped into semesters, 
select the number of terms per semester 
and click [Next].

7. Check the information in the Summary and 
click on the [Back] button to edit if needed. 
Click the [Done] button.

Subjects Use this preference to add subjects, 
edit subjects, or delete subjects.

1. Click on the Preferences menu and 
select Subjects.

2. The Subjects dialog box will open.
• If you are adding a subject, click on the 

[Add] button and type the name of the 
subject you want to add. 

• To edit a subject, scroll down the list 
until you find the subject, and click on it. 
Then click the [Edit] button, and make 
changes.

• To delete a subject that is not being used, 
scroll down the list to find the subject, 
and click on it. Then click the [Delete] 
button. Subjects being used cannot be 
deleted.

3. Click the [OK] button.
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Categories Use this preference to create or 
change categories for assignments you 
include in your Gradebook.
• Create or edit categories
• Assign weight to each category
• Decide whether or not to drop worst 
grade for each category
• Decide how much extra credit should 
be worth.
• Select Total Points Earned or 
Category Weights to calculate grades.

1. Click on the Preferences menu and 
select Categories.

2. The Categories dialog box will open.
• Edit an existing category by clicking the 
box or Type in a new category in a blank 
field.
• In the Calculate Grades Using section, 
select “Category Weights” or “Total 
Points Earned.”
• Edit or type in a weight value (if using 
category weights) and click on the “Drop 
Worst Score” box, if applicable. 

3. When you have finished adding or 
changing your category preferences, click 
the [OK] button.

Grading Scale Use this preference to select the 
grading scale used in calculating 
grades.

1. Click on the Preferences menu and 
select Grading Scale.

2. The Grading Scale dialog box will open.
3. Select one of the options from the 

Grading Scale menu. 
4. You can change the numerical value(s) for 

the grading scale option you selected.
5.  When you have finished changing your 

grading scale preferences, click the [OK] 
button.

Exams Use this preference to set the percent 
that the exam weights the grade, and 
also decide if the grade is the Term 
Grade, Semester Grade, or Final Grade 
(default).

1. Click on the Preferences menu and 
select Exams.

2. The Exams dialog box will open. Select a 
Grade option to match your school’s 
program.

3. The default setting is 25 percent of the 
selected grade. If you want to change the 
percent, type in a different percent in the 
“Exams are...” blank.

4. When you have finished changing your 
Exam preferences, click the [OK] button.

Preference What it does How to change it
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Password The password preference lets you 
change the password to maintain 
AccelTest security. You should change 
the default admin password to a 
password of your choice after 
AccelTest is installed.

1. Click on the Preferences menu and 
select Password.

2. The Change Password dialog box will 
open. 

3. Type in your current password in the 
Current Password box, then press <Tab>. 
Type in your new password in the New 
Password box, press <Tab>, and then type 
your new password in the Confirm 
Password box. 

4. When you have finished changing and con-
firming your Password preference, click the 
[OK] button.

Preference What it does How to change it
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Scanner Settings Use this preference to set the scanner 
port setting, and the scanner 
sensitivity. 

Port Setting: First, make certain the 
scanner is installed according to the 
instructions in the AccelScan User’s 
Guide.

• Start your computer and AccelTest. If 
AccelTest does not detect the scanner, 
you may need to manually set the 
scanner port setting to the computer 
port you have connected your 
AccelScan to.

Sensitivity Setting: You may need to 
adjust scanner sensitivity to allow for 
differences in the way students mark 
scan cards. If the AccelScan is too 
sensitive to stray marks, decrease the 
sensitivity. If the AccelScan does not 
recognize some marked answers, 
increase the sensitivity.

• If AccelTest still does not detect the 
AccelScan scanner, confirm that your 
computer system specifications meet 
the requirements in “Where to Find the 
System Requirements” on page 6. 

1. Click on the Preferences menu and 
select Scanner Settings.

2. The Scanner Settings dialog box will 
open. 

• To manually set the Port setting, click on 
the Port drop-down list and click on the 
appropriate computer port. 
• To change the scanner sensitivity click 
on the pointer and move it to change the 
sensitivity.

3. Click the [OK] button.

Preference What it does How to change it

Click to select 
a different 
port.

Macintosh: 
Move the 
slide to 
change 
AccelScan 
sensitivity.

Click to select 
a different 
port.

Windows: 
Move the 
slide to 
change 
AccelScan 
sensitivity.
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Reports The following reports have settings 
you can change:
• Answer Key
    Print/Preview Setting preference
• Assignment Analysis 
    Print/Preview Setting preference
    Display Item Details
• Assignment 
    Print/Preview Setting preference
    Sort Order preference
• Assignment Results
    Print/Preview Setting preference
    Questions to display
    Show correct answers
    Auto print after student score
    Batch print report
• Free Response Grading Worksheet
    Print/Preview Setting preference
• Gradebook Summary
    Print/Preview Setting preference
• Group Assignment 
    Print/Preview Setting preference
    Sort Order preference
• Overdue Assignments
    Print/Preview Setting preference
• Program Information 
    Print/Preview Setting preference
• Student Grade 
    Print/Preview Setting preference
• Student Record 
    Print/Preview Setting preference
    Page Break after student preference

For more detailed information and instructions, 
see “Setting Reports Preferences” on page 56.
1. Click on the Preferences drop-down 

menu and go to Reports. 

2. Click on the report you want to set 
preferences for.

3. In the Report Options Dialog Box, make 
your changes and click [OK].

Preference What it does How to change it



Gradebook

55

G
rad

eb
o

o
k

Assignment 
Creation

This preference includes several 
settings that allow you to customize 
your assignments.
The Assignment Creation preference 
includes:
• Favorite Item Types
• Default Fonts
• Variations
• Multiple Choice
• True/False
• Yes/No
• Matching
• Ranking
• Modified True/False
• Numeric Response
• Fill in the Blank
• Short Answer
• Essay

For more detailed information and instructions, 
see “Setting Assignment Creation Preferences” 
on page 58.
1. Click on the Preferences drop-down 

menu and go to Assignment Creation.

2. Find the setting in the drop-down menu 
that you want to change and click on it.

3.  Make your changes and then click [OK].

Preference What it does How to change it
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Setting Reports Preferences

You can change your reports preferences. 

To change your Report Preference settings, follow these steps.

1. Start AccelTest. From the Getting Started 
screen, click on the Preferences drop-
down menu and go to Reports.

2. Click on the report you want to set 
preferences for.

3. In the Report Options Dialog Box, make 
your changes and click [OK].

Print Preview

One is Print/Preview setting, available for all reports. Print/Preview determines what happens when 
you print your report. There are three choices available:

• Ask - asks if you want to preview or print the report selected. This is the default.

• Always Preview - always shows preview before you start to print.

• Always Print - always prints without asking or showing preview first.

Sort/Order

Another option that can be set is for Sort Order. The setting for Sort Order determines how the 
information in the report is sorted. The Assignment and the Group Assignment reports are the 
only two reports that allow you to set how they are sorted. Since the reports differ, the options 
available differ as well. 

Sort Order for Assignment tab; see Sort Order for Group Assignment, on the following page.

Click on the Sort Order drop-down list in the Report Options dialog box, and click on your 
preference:      

• Title - sorts list by title. This is the default.

• Modification Date - sorts list by modification date, oldest to newest.

• Total Points - Sorts list by total points, lowest to highest.
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• Assigned - Sorts with unassigned first, followed by assigned.

Sort Order for Group Assignment; see previous paragraph for Assignment tab

Click on the Sort/Order drop-down list in the Report Options dialog box, and click on your 
preference: 

• Student Name - Sorts alphabetically by student last name. This is the default.

• Points Earned - Sorts by points earned, lowest to highest.

• % of Points Possible - Sorts by percent of points possible, lowest to highest. 

Questions to Display for the Assignment Results Report. 

Click on the Questions to Display drop-down list in the Report Options dialog box, and click 
on your preference: 

• Missed Questions - Shows missed questions. This is the default.

• All Questions - Shows all questions.

Show Correct Answers for the Assignment Results Report.

Click on the Show correct answers check box to show correct answers for questions.

Autoprint for the Assignment Results Report. 

When Auto print after student score is checked, the report prints automatically when the student 
scores the assignment using AccelScan. This is the default setting.

Batch Print for the Assignment Results Report.

If Autoprint after student score is checked, you can click on the check box next to Batch print 
report to batch print the report. This will delay printing of all Assignment Results Reports until the 
scanning window is closed, and then print them as a batch. 

Page Break after Student for the Student Record Report.

When Page break after student is checked, the report prints a separate page for each student. This is 
the default setting.
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Setting Assignment Creation Preferences

You have many options available when 
you create your assignments in 
AccelTest. These options range from 
what item types appear in the opening 
screen (Favorite Item Types) when you 
create your assignment, to the 
instructions, number of points and 
number of answer lines provided for an 
essay assignment.

The instructions in steps 1-3 apply to 
every setting. Detailed descriptions for 
each setting, from Favorite Item Types 
to Essay, follow step 3.

1. Click on the Preferences drop-down 
menu and go to Assignment Creation.

2. Find the setting in the drop-down menu that you want to change and click on it.

3.  Make your changes and then click [OK].

• Favorite Item Types:

When you create your New Assignment in the 
Assignment tab, notice that there are four item 
types on the New Assignment dialog box. (See 
“Creating Questions for a New Assignment” 
on page 64.) 

To change any of the items in the New 
Assignment dialog box, use steps 1-3 above and 
select what four types of items appear using the 
Favorite Item Types setting. 
Note: Items you remove can be found by 
clicking [More Item Types] in the New 
Assignment window.

In the Assignment Creation Options dialog 
box, click on an item you want to remove 
under Favorite item types, and click [Remove]. 
Then click on the item type you want to add 
under Item types to choose from, and click 
[Add]. Your choice appears under Favorite 
Item types. Repeat to change other item types. 
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• Default Fonts: 

Use the drop-down lists and buttons 
to select:
the font, 
font size,
and Bold, Italic, and       Underline 
styles 

These apply to Body, Section Name, 
and Instruction in your assignments. 
These font settings effect both the 
displayed assignment and printed 
assignment.

• Variations

Variations allows you to set the number of 
variations in your printed student assignments. 
AccelTest has the ability to shuffle the items 
(questions) within the group, to make 
variations. If you have six items, and shuffle 
items is checked, the items appear in a different 
order on each variation.

If you want to disable shuffle, click on the 
check mark in the box next to Shuffle. The 
default is on.

You can set the number of assignment variations to print by selecting a number in the 
Number of Variations drop-down list. The default is 1.

The assignment variation is identified by a letter after the Assignment ID number. The 
students need to include the letter after the ID number on their scan card.

• Multiple Choice:

Enter or edit the instructions for your multiple 
choice questions in the Instructions box.

You can also change the Default Points value for 
each assignment item.

The default Distractors setting is A to D, which 
gives 4 choices (correct answer plus 3 
distractors) per multiple choice item. You can 
select as few as one distractor (A) and as many as 
9 (A-I).

Click on the Layout drop-down list to select 1, 2 or 3 columns.
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• True/False:

Enter or edit instructions for the true/false 
items in the Instruction box.

You can also change the Default Points 
value for the assignment items.

• Yes/No:

Enter or edit instructions for the yes/no 
items in the Instruction box.

You can also change the Default Points value 
for the assignment items.

• Matching:

Enter or edit the instructions for your matching 
questions in the Instructions box.

You can also change the Default Points value for 
the assignment items.

The default Distractors setting is A to D, which 
gives 4 choices (correct answer plus 3 
distractors) per matching item. You can select as 
few as one distractor (A) and as many as 9 (A-I).

Click on the Layout drop-down list to select 
Side by Side, or 1, 2 or 3 columns.

The Items Per Group drop-down list, allows selection of 1 to 20 items.
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• Ranking:

Enter/edit the instructions for your ranking 
questions in the Instructions box.

You can also change the Default Points value 
for the assignment items.

The default Distractors setting is A to D, 
which gives 4 choices (correct answer plus 3 
distractors) per Ranking item. 

You can select as few as one distractor (A) and 
as many as 9 (A-I). 

Click on the Layout drop-down list to select 
Side by Side, or 1, 2 or 3 columns.

The Items Per Group drop-down list, allows selection of 1 to 20 items.

• Modified True/False:

Enter or edit instructions for the modified true/
false items in the Instruction box.

You can also change the Default Points value for 
the assignment items.

You can set the number of blank lines per answer.

• Numeric Response:

Enter or edit instructions for the numeric 
response items in the Instruction box.

You can also change the Default Points value for 
the assignment items.

You can set the number of blank lines per 
answer.
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• Fill in the Blank:

Enter or edit instructions for the fill in the 
blank items in the Instruction box.

You can also change the Default Points value 
for the assignment items.

You can set the number of blank lines per 
answer.

• Short Answer:

Enter or edit instructions for the short answer 
items in the Instruction box.

You can also change the Default Points value 
for the assignment items.

You can set the number of blank lines per 
answer.

• Essay

Enter or edit instructions for the essay items in 
the Instruction box.

You can also change the Default Points value 
for the assignment items.

You can set the number of blank lines per 
answer.

Window

The Window drop-down menu provides a 
convenient way to switch between the Getting 
Started screen, the Assignment tab and the 
Gradebook. Click on the Window drop-down menu and then click on the program screen or 
function you want. 
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Using Quick Assignment in AccelTest 

The Quick Assignment feature lets you quickly create multiple choice assignments (tests, 
homework, etc.) in AccelTest.

• You will first enter title, subject, total points and number of items.

• You can then enter your question and answer content. 

1.  To use Quick Assignment, start AccelTest 
and click on the Assignment tab in the 
Getting Started screen.

In the Assignment tab screen click on 
the [Quick Assignment] button.

In the Quick Assignment screen, type 
your assignment title in the Title box.

In the Subject drop-down list, select your 
subject.

Enter a number for the total assignment 
points in the Total Points box.

In the Multiple Choice Items box, type the 
number of items (questions) you want.

In the Your Assignment Will Have 
section, you will see the number of items, 
points per item and total points for your 
assignment. Click [OK].

2. A progress bar appears to indicate AccelTest is creating your assignment. 

Using Assignments

Replace  
with 4 tabs 
panel
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3. The Assignment Editor Wizard (Assistant 
in Mac) opens. 

Enter your content for assignment questions 
and answers using the Wizard/Assistant. 
See “How to Use the Assignment Editor” on 
page 74.

4. After you have entered your assignment 
content, run a spelling check. See “Spelling 
Check” on page 80. You should also validate 
your assignment. See “Validate 
Assignment” on page 81.

5.  From the File drop-down menu, click Save. 

6. If you want a printed copy of your 
assignment, click on the File drop-down 
menu and click Print.

Creating Questions for a New Assignment

You can use AccelTest to create an assignment comprised of different types of items (questions). 
The assignment can be a combination of assisted and free response items.

Assisted Response items or questions require that the students mark their answers on a scan card, 
so the scores can be totaled using AccelScan. 

Examples of Assisted Response items (questions) are listed in the table below.

Free Response items or questions require students to write a number, or a word, or perhaps a 
sentence or paragraph to answer a question. 

Examples of Free Response items (questions) are listed in the following table.

assisted Response Items (Questions) Abbreviation

Multiple Choice MC

Matching M

Ranking R

True/False TF

Yes/No YN
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When you create your 
assignment, you specify the item 
type and number, as well as the 
points per question. AccelTest 
displays a running total of the 
points for each assignment as you 
go through the list and select the 
types of items you want.

1. Start AccelTest and click on the Assignment tab button in the Getting?? Started screen.

2. In the Assignment  dialog box, click on 
[New Assignment].

3. In the New Assignment dialog box, 
type your title in the Title box.

At Subject, click on the drop down list 
and click on your subject. 

Under Item Types, find the types of items 
you want to use. 

Click [More Item Types] for additional 
types. 

Note: You can specify your own 
favorite Item Types that appear in this 
screen. See “Setting Assignment 
Creation Preferences” on page 58.

4. In the expanded New Assignment dialog box, fill in the boxes that are applicable for your new assignment.

For example, if you will have Matching (or Ranking) Item Types, enter the number of items in the box under 
“Number of items.” 

Free Response Items (Questions) Abbreviation

Essay E

Fill in the Blank F

Modified True/False MTF

Short Answer SA

Numeric Response NR

Replace  
with 4 tabs 
panel
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The maximum number of item choices for Matching or 
Ranking is 9 per group. If the number of items needed is 
greater than 9, divide the number by 9 to determine the 
number of groups, rounded up to the nearest whole 
number.    

For example, for 15 items, when you divide by 9, you will 
get 1.66. This means you need 1 group + 1, rounded up to 
2 groups. 

Under Number of Items, enter numbers for Multiple 
Choice, Matching, Numeric Response, etc., if applicable.

Then, enter numbers for points under Points Per Item, 
where applicable.

Note the total Number of Items and the point Total change 
as you fill in the boxes. 

5. When you have entered all of the applicable information, 
click on [OK]. 

6. The Assignment Editor Wizard/Assistant will open. See “How to Use the Assignment Editor” on page 74.

Creating New Score Key for Existing Assignment

You can utilize existing assignments and create a score key for them. For this example, assume that 
you are using 25 multiple choice questions at the end of Chapter 3 in a History textbook. 

• If you are going to enter your answers at the computer complete steps 1 and 2, then skip 
to steps 6 through 7. 

• If you are going to create a scan card by hand, read the information in the Hint below, 
then complete steps 1 and 3 through 7.

Hint: If you want to create a score key scan card when you are away from your computer, write it 
up by hand and use AccelScan to scan your answers in to AccelTest when you return. You can use 
any number of questions from 1 to 25 for the short scan cards, and 1 to 50 for the long scan cards.
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On an AccelTest scan card, write the name of your 
Assignment on the Name line. 

Next, on the same AccelTest card, mark the 
ANSWERS to the questions by filling in the 
bubbles with the correct answers. 

For example, the answer to question 1 is “B” and 2 
is “A” and so forth. Fill in the appropriate bubbles 
for all of your questions. Follow steps 1 and 3 through 7 to use the hand entered card.

1. Start AccelTest. In the Getting Started 
screen, click on Assignment tab. In the 
Assignment screen, click on [New Score 
Key].

In the New Score Key Assignment dialog 
box, enter your assignment title in the Title 
box.

In the Subject drop-down list, select your 
subject.

In the Assisted Response and Free 
Response sections, fill in the boxes applicable for Number of Items and Point Value. Click [OK].

2. The CHAPTER 3, 25 QUESTIONS screen 
appears, showing a blank scan card.   

a. Indicate the ANSWERS to the 
questions. At item 1 click on the 
A, B, C, etc. bubble to indicate the 
answer that is correct. 

b. When you click on the bubble to 
select your answer, the point 
value for the item appears on the 
right side. You can set point 
values for individual items here, 
by clicking in the value and typing 
the value you want this question 
to have. 

c. When you have selected the 
answer by clicking on the 
appropriate bubble, (and, if necessary, adjusted the point value), go on to the next item 
(question). Go directly to step 6 when all of the assisted response question’s 
answers have been entered.
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3. If you did fill out the bubbles on a scan 
card, click on the [Scan Form] button at 
the top. Then, go to step 4. 

3. The Scan Answer Key screen appears.

4. Insert the AccelTest scan card you have filled in, with the arrow pointing toward the AccelScan.

5. In a moment, the answers that you filled in on your card (or typed on your computer) will show up on the 
screen.
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If you see errors on the form, correct 
them. Simply click on the question 
number needing correction and then 
click on the incorrect answer, to 
unselect it. The bubble will become 
white again. Next click on the bubble 
for the correct answer to select it 
(darken the circle). When the card is 
correct, click [Done]. 

6. When you are asked to save changes, 
click [Yes]. You now have an answer 
key for grading this assignment. 

AccelTest will automatically assign a 
3-digit number to your assignment 
when it is assigned in the Gradebook.

To prepare AccelTest for students to 
score their scan cards, see “Preparing 
AccelTest for Students to Score Scan Cards” on page 16.

Note: Only assisted response items are entered on the scan card. Free response items must be 
graded by the teacher and the scores entered through the gradebook.

Combinations of assisted response and free response assignments allow assisted response item 
scanning by the students or teacher. The scanned, assisted response portion of the assignment gets 
entered in the Gradebook. AccelTest scores free response items at 100 percent correct, until the 
teacher grades and adjusts scores.

For instructions on editing a score key, see “Teacher Instructions for Editing a Score Key” on 
page 70.
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Teacher Instructions for Editing a Score Key

Before editing a score key you must 
make certain it is not assigned to any 
students. Check the Assigned column; 
Yes indicates it is assigned to one or 
more students. If No is in the Assigned 
column, it is not assigned and can be 
edited. 

If you want to edit an assignment (and 
the score key for an assignment) you 
created in the Assignment tab, go to the 
Assignment tab and edit the 
assignment. See “How to Use the 
Assignment Editor” on page 74. When 
you save your changes, any changes you 
made that changed score key answers 
will be reflected in the score key.

If you have a score key for an existing 
assignment that was not created in the 
Assignment tab, you can edit the score 
key. 

The assignment Type will be Score Key 
in the Assignment tab. 

The Score Key is the only part of a 
Score Key assignment in the 
Assignment tab.

To edit a Score Key assignment, click 
on the assignment and click [Edit].

AccelTest opens your score key.
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When your score key appears you can 
start editing. If you want to add an item, 
click on [Add Items]. 

In the Add Items dialog box, find 
Assisted Response if you are adding 
assisted response items. 

Type in the item numbers in Items to 
Add box. 

Then type in the point value in the Point 
Value box. 

If you are adding free response items, 
under Free Response, type in the Items 
to Add and Point Value there as well.

 Click on [OK] when finished.

To delete an item, click on the item you 
want to delete, and then click on [Delete Items].
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 To correct an incorrect answer for an 
item, simply click on the item number 
needing correction and then click on 
the incorrect answer to unselect it. The 
bubble will become white again. Next 
click on the bubble for the correct 
answer to select it.

To set points, click on [Set Points].

For Assisted Response items, type the 
point value in the Point Value box.

For Free Response items, type the point 
value in the Point Value box.

Click on [OK] when finished.

If you want to edit the title or 
subject, simply click on the [Properties] 
button. 

In the Save Assignment dialog box, 
type new Title information, and from 
the Subject drop-down list, select your 
subject. 

Click [OK] when done.

Creating New Points Only Assignment

Points Only information can be recorded in this assignment. An example would be oral 
participation in the class. 

Only teachers do scoring in the Points Only assignments. Students do not do any scoring of scan 
cards for this type of assignment.

For detailed instructions on creating a Points Only assignment, see steps 1 through 5 on page 73.
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1. To create a Points Only Assignment, 
from the Assignment tab click on 
[New Points Only]. 

2. In the New Points Only dialog box, 
type your assignment title in the Title 
box.

3. Select your subject in the Subject 
drop-down menu, and then 
enter the points in the Points box.

4. Click [OK]. 

5. Your Points Only Assignment will need 
to be added to the Gradebook. Go to 
the Gradebook and add this points only 
assignment. 

You can enter student scores in the 
Gradebook.
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How to Use the Assignment Editor

The Assignment Editor allows you to input the content of your assignment items (questions). To 
start entering or editing your item content, click on the first item you want to edit and click [Edit].

 

Note: Once you have created your 
assignments, you can use the 
Assignment Editor to edit and update 
them, with class and subject content 
changes. Assignments already given to 
students cannot be edited, but you can 
edit a copy.

Assignment Editor Buttons

You can use the buttons at the top of the Assignment Editor to navigate within your assignment, 
edit content, and adjust your assignment’s appearance.

Add Item - Click at the location 
where you want to add an item and 
then click on the [Add Item] button.

In the Add Item dialog box, select the type of 
Assisted Response or Free Response item to add. 
Click [OK].

Remember that adding items will change your total 
points for the assignment. 

The added items have a default point value of 1, 
which you can adjust at the same time you edit 
your item to insert content.

Note: Added items may not appear where entered. Items of similar type are kept together. If you add a True/
False item in the midst of a number of Multiple Choice items, it will appear after the last Multiple Choice item.

Assignment Editor Buttons
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Edit Item - Use the Edit 
Item button to modify, 
add and delete 

information in your assignment. 
Simply click at the location where you 
want to make your change.

In the area where you click, lines of 
your assignment content will be 
highlighted in yellow. 

You can highlight the type of 
assignment and instructions, or any 
individual, numbered item. 

Enter & Edit Text: When you click on 
Edit Item, you will go to an edit screen 
to enter or edit text that is highlighted. Your new text replaces the highlighted text when you type.

 This is what the edit screen looks like.

Moving: To move the highlight 
forward in the edit screen, use your 
keyboard <tab> key. Use <Shift> + <Tab> 
keys to move back. You can also move by 
clicking on a word or field.

Cancelling Changes: If you make a 
mistake editing an item, and want to go 
back to your original, click [Done] and 
then [Don’t Save]. 

Saving changes & Moving between 
Items: To save your changes, and move to 
the next block of text in your 
assignment, click on the [Next] button. 
Clicking on [Previous] also saves your 
changes, and lets you move back to a 
previous block of text. At the last item you 
edit, click [Done] and then [Save]. 

Graphics: To import a graphic in your 
assignment, click on the [Import Graphic] 
button. For more information see 
“Importing Graphics Files in an 
Assignment Item” on page 78.

Text Content: To 
make a change to the 
highlighted text, simply 
type in your new text.

Item choices 
& Columns: Go 
here to change 
the number of 
choices for each 
item, or select 1, 
2, or 3 columns 
for the item. 

To Import Graphics click here.

Shuffle Item 
Choices: If you 
do not want to 
shuffle an item’s 
choices, select 
None. Other 
options vary 
with number of 
answer choices.

Text format: Change the font, size and 
select boldface, italic and underline.
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Correct Answer at A: Notice as you type in your assignment items, that by default, you always type your 
correct answer at A. This makes assignment data entry easy. 

• AccelTest can shuffle your item answers so that the correct answer will not always be A on the 
assignment the students receive. 

• The Shuffle drop-down menu allows you to select, for each individual item, None (no shuffle), 
a-b shuffle, and a-c shuffle (with default 4 answer choices). All (shuffle all) is the default setting.

• If you have selected more item answers (click on the Choices drop down menu), your shuffle options 
increase correspondingly up to 9, and decrease if you selected less than 4.

Setting “Type correct answer here” Position: You can change an item’s correct answer position from the 
default A to B, for example.

If you want to change the position of 
your correct answer to B, for example, 
click on the answer field for B and type 
in your correct answer; then, enter a 
Distracter (incorrect answer) in A. 

Next, click on the Answer field, below 
your answer choices, and replace A 
with B. 

Changing Item Point Value: To change 
an item’s point value, click on the 
Points field, and enter the new point 
value. The total points for the 
Assignment will reflect this items point 
change.

Saving Changes: Click on the [Done] 
button and then [Save] to save changes.

To give this assignment to your students, see“Add Assignments to Gradebook and Assign to Students” on 
page 21. 

Note: By default, student copy variations 
will show different positions (letters) for the 
corrent answer with All selected in the 
Shuffle drop down menu. 
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Delete Item - If you 
want to delete an item, 
click on the item. 

The selected item will be highlighted. 
Click on the Delete Item button. 

This will delete the item, and reduce 
the item count by one. 

The Points Possible will decrease by 
the deleted item’s point value.

Properties - Click on the Properties 
button. The Title/Subject tab allows 
you to enter/edit your title and 

subject. Type title information in the Title box.

Use the Subject drop-down menu to select the 
subject.

The Fonts tab allows you to change the appearance 
and display settings. 

Use the drop down lists to select the font, as well 
as font size and Bold, Italic, and Underline styles 
for Body, Section Name, and Instruction.

Size    Style
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The Variations tab allows you to set the number of 
variations in your printed student assignments.

• Variations allows you to set the number of 
variations in your printed student assignments. 
AccelTest has the ability to shuffle the items 
(questions) within the group, to make 
variations. If you have six items, and “Shuffle 
Items” is checked, the items appear in a 
different order on each variation. 

• If you want to disable shuffle, click on the check 
mark in the box next to Shuffle Items. The 
default is on or enabled.

• You can set the number of assignment 
variations your students receive by clicking, then 
selecting a number in the Number of Variations drop-down list. The default is 1.

• The assignment variation is identified by a letter after the Assignment ID. The students need to include 
the letter after the ID number on their scan card.

The Options tab lets you decide whether to display 
the points for each item on the assignment. The 
default is to show item points. Click on the check 
box to remove the check mark and hide individual 
item points.

Importing Graphics Files in an Assignment Item

AccelTest uses QuickTime™ to handle the graphics files you import. Common graphic files 
supported are: tif, gif, pict, png, psd, jpg and bmp.

1. To import a graphic in your assignment, start AccelTest, click the Assignment tab, 
and click on the name of your assignment; then, click [Edit]. 

2. When the Assignment Editor Wizard or Assistant starts, find the item where you want to place your graphic, 
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and double-click on the item. 

3. When the Item opens, click on the 
location where you want to place 
your graphic. 

Then, click the [Import Graphic] 
button.

4. Navigate to the drive and folder 
where your graphics file is 
located. Double-click on the 
folder. (In Windows computers, 
you may need to click on the 
“Files of type” drop-down menu 
and select the type of graphic file 
you are importing.)
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Click on the file name. Click [Open].

The image will be imported. Use the scroll bar 
to go to the bottom of the image if needed.

Click on the red square in the corner of the 
image and drag to resize the image. 

To delete the image, click on it and press the 
<Delete> key.

If you click and drag the red square at the 
bottom or side, you will stretch/shrink the 
image vertically or horizontally, respectively. 
Click [Done] when finished.

If you decide not to use a graphic, click on 
[Edit] and then [Replace Graphic] to select a 
new image. 

When you have finished adjusting your 
graphic, click [Done] and then [Save] to save your changes.

Note: To limit the size of your assignment files, limit the use of imported graphics, and/or import only smaller 
graphics files.

Spelling Check

To check the spelling in your assignments, in the 
Assignment tab, click on the assignment name and 
click [Edit] to open the Assignment Editor.

Click on the Assignments drop-down menu and go to 
Spelling and then click Check. (In Windows press 
<Ctrl + l> and for Macintosh press <Command + l> to 
start spelling check.)
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Click on the [Options] button in the Spell 
Check dialog box or Options in the 
Assignments drop-down menu to open the 
Spell Check Options dialog box. 
To enable an option, click on the check box 
next to it. The options include:

• Suggest word phonetically

• Suggest split words

• Ignore words in all caps

• Ignore words with mixed digits

Click [OK] after you change options.

In the Spell Check dialog box, when you see a 
word in the Not in Dictionary box, you can 
choose to Ignore (Ignore All), Change (Change All), or Add (to dictionary). Click [Close]. 

Validate Assignment

When you complete work on an 
assignment, or when you import an 
assignment, you should check it with 
AccelTest’s Validate feature. Validate 
checks for Missing Fonts, Blank 
Answer Field, and Blank Points Field.

To validate an assignment, in the 
Assignment tab, click on the 
assignment and click [Edit] to open 
the Assignment Editor.

In the Assignments drop-down 
menu, click on Validate. When the 
validation is completed you should 
see a message stating no problems 
were found.
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Click [OK] when the message appears.

If any problems are found, you will see 
a message stating that there were 
problems found and a list, by item, of 
the problems. 

Click close and correct the problems 
listed.

Printing a Single Copy of an Assignment

You may want to check how your 
assignment looks when it is printed. 
To print a copy of an assignment, 
from the Assignment tab, click on 
the assignment Title. 

Then, click on the File drop-down 
menu and click on Print.
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Importing and Exporting AccelTest Assignments

Importing Assignments

Follow these steps to import your AccelTest assignments that were created on another computer 
using AccelTest. (To export assignment information, see “Exporting Assignments” on page 84.) 

1. From the Assignment tab, in the Assignments drop-down menu, click on 
Import.

2. In the dialog box that appears, select the location of your assignment data 
you are going to import. Then, click [Open].

Windows computers: Click on the “Look in” drop-down menu and choose 
the drive (such as a floppy disk drive, your hard drive, or a network drive) 
where the folder and the file is located. Locate the folder and double-click on it. Click on the import file (the 
import file extension will be “.ata”), and then click [Open]. 

Macintosh computers: First, click the [Shortcuts] button. Then, double-click on the drive in the list (such as 
your hard drive, a floppy disk drive, or a network drive) where the folder and file is located. Scroll to the folder 
and double-click to open it. Click on the import file (the import file extension will be “.ata”) and then click 
[Open]. 

3. The file will open for editing. Save and close the file if 
you do not want to edit it at this time.    

Click on the File drop-down menu and click Save. 

If you have an existing assignment with the same title, 
a window will open; click [OK] and type a new title.

Click [OK] to save. 

Click [Done] to close the assignment.

First: Choose the drive 
and then the folder 
where your import file 
is located.

Second: Click on the 
file.

Third: Click [Open].
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Exporting Assignments

Follow these steps to export your AccelTest assignments. You can use the export file as a backup, or 
you can use it to import your assignment into AccelTest at another computer. (To import 
assignment information, see “Importing Assignments” on page 83.) 

1. From the Assignment tab, click on the assignment you want to export, then 
in the Assignments drop-down menu, click on Export.

2. In the dialog box that appears, select a location for your exported 
assignment data. Then, click [Save].

Windows computers: Click on the “Save in” drop-down menu and choose 
the drive where you’d like to save the file (such as a floppy disk drive, your 
hard drive, or a network drive). If you want to save the file inside of a folder 
on that drive, double-click on the name of the folder to open it. If needed, 
create a new folder. 

By default, the export file extension will be “.ata”. To choose a different name, click in the “File Name” blank 
and type a new name; be sure to end the name with “.ata”. When you’re ready to save the file, click the [Save] 
button.

Macintosh computers: First, click the [Shortcuts] button. Then, double-click on the drive in the list where 
you want to save the data (such as your hard drive, a floppy disk drive, or a network drive). If you want to save 
the file inside of a folder, double-click on the folder name to open it. If needed, create a new folder. 

Then, click in the Name blank and type the name you want to use for the file. Be sure to end the name with 
“.ata”. When you are ready to save the file, click the [Save] button.

First: Choose the drive. 
Double click the folder 
where you want to 
save the export file. 

Second: Type a name 
for the file.

Third: Click [Save].
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Deleting Assignments

You can delete assignments you will not use again. 

If the assignment has been added to the Gradebook, you must remove it from the Gradebook 
before you can delete it from the Assignment tab. See “Removing/Clearing Assignments in the 
Gradebook” on page 24.

To delete the assignment, go 
to the Assignment tab. Click 
on the assignment you want 
to delete.

Click Delete in the 
Assignments drop-down 
menu.

You will be asked if you are 
sure you want to delete the 
assignment. Click [Yes] to 
delete. 



Preferences

86

P
re

fe
re

n
ce

s

A session may be an in-class lesson, homework exercize or a quiz or test. Sessions are either teacher-
paced or student-paced.

The Sessions function consists of:

• Review Panel
The Review Panel is used for teacher-paced sessions. The user can review how students 
responded to each item in a session.

• Responder Panel
The Responder panel uses three different display modes. 

• The user can select a Detailed Session Mode. It is used for student paced sessions when items are not 
being projected; similar to review session.

• There is a Session Toolbar Mode used for projecting external content (such as PowerPoint) or individual 
items from an assignment.

• Finally, there is a Student Paced Session Mode which shows user which assignment/question each 
student is on.

Review Panel (Teacher-Paced)

To use the Review Panel...

Responder Panel

To use the Responder Panel...

Session Toolbar Mode Panel

The Session Toolbar Mode Panel....

Using Sessions
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Pacing Sessions

Sessions are either teacher paced or student paced. 

• Teacher paced sessions....

• Student paced sessions....

•



88

The Libraries capability allows you to manage your installed libraries and install content.

There are two kinds of content you can install:

• Import existing Print Engine book files

• Install book files from Renaissance Learning

Importing Print Engine Book Files

There are....

Installing Renaissance Learning Book Files

To install book files from Renaissance Learning....

•

•

Using Libraries
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Determining Grades

By default, grades are determined in AccelTest from the total points earned. The points earned are 
divided by the points possible on each assignment to determine a grade.

Term, Semester and Final Grades

Term grades are derived from the assignments. Semester grades are computed by averaging term 
grades. Final grades for the year are computed using semester or trimester grades if there is no final 
exam. (If there are no semesters in the school year, only term grades are used.)

For example:

1st Term 81%

2nd Term 75%

3rd Term 82%

4th Term 86%

1st Semester (81% + 75%)  ÷ 2 = 78%

2nd Semester (82% + 86%)  ÷ 2 = 84%

Final (78% + 84%)  ÷ 2 = 81%

Grade computation includes final exam grades as specified in your Exams preference settings. (See 
“Setting Exams Preference” on page 13.) For example, if final exams are 30% of the term grade, 
and a student earned 75% on the exam:

Term Grade 81% x 70 = 56.7

Final Exam 75% x 30 = 22.5

Grade (including exam)                79.2%

If final exams are 20% of the semester grade, and a student earned 72% on the exam:
Semester Grade 78% x 80 = 62.4

Final exam 72% x 20 = 14.4

Grade (including Exam)               76.8%

You may choose different categories, weights, and grading options for each term in the school year. 
This gives you the flexibility to change how you compute grades during the course of the school 
year. 

Appendix: AccelTest’s Grade Calculations
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Grade Calculations

Points Possible

AccelTest uses points earned divided by points possible to calculate grades. The student’s points 
earned is divided by the points possible. This percentage determines a letter grade, based upon the 
current letter grade percents.

Category Weights

You can set AccelTest to have certain categories of assignments contribute a fixed amount to each 
student’s grade. To do this, you should use category weights to compute grades.

The percent correct within each category will be computed. Then grades are determined by a 
weighted average of the percent correct within each category. If you want to use category weights, 
see Calculate Grades Using section in the Categories dialog box on page 12. 

Extra Credit

You can use extra credit assignments to allow your students to improve their grades. There are two 
ways to do this, when you give the assignment to your students from the Gradebook.

• You can select the Extra Credit category, and use this category for all of your extra credit work. 
This is the preferred way to handle extra credit, if using category weights to compute grades.

• You can designate an assignment in any category (homework, test, or quiz, for example) as an 
extra credit assignment. You may prefer to do this, especially if you are using points possible to 
compute grades.

See “Add Assignments to Gradebook and 
Assign to Students” on page 21. Step 2 
describes how to select the extra credit 
category, as well as how to make a 
Homework, Test or Quiz assignment extra 
credit.

Using Points Possible: Assignments 
designated as Extra Credit contribute to each 
student’s points earned, but not to the total 
points possible. When you give assignments 
for Extra Credit, it is possible for students to 
earn enough points so they will achieve a term or semester grade above 100%. AccelTest limits the 
grade to 100%, however.

Homework Chapter      19/10

Quiz Chapter                18/10

Homework Questions     7/10

Homework Chapter 2   10/10

Homework Chapter 3     9/10

Extra Credit Homework  5/0

Test Chapters 1-4            9/10

Total                              57/60 = 95%
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Using Category Weights: When you check Assignment is extra credit, the assignment effects 
grades differently when you use category weights, regardless of whether the assignment category is 
Homework, Test, or Quiz. (To select Assignment is extra credit, see Enter Gradebook Details in 
step 2 under “Add Assignments to Gradebook and Assign to Students” on page 21.) 

Regardless of category, Extra Credit Assignments improve the percent correct within that category. 

If you click on Assignment is extra credit for an assignment in the Homework category, this would 
increase the percent correct in that category for students earning points on that assignment.

Assignments in the Extra Credit category are treated like assignments in any other category. The 
percent correct on these Extra Credit assignments is multiplied by the category weight. 

But the Extra Credit category weight is not included when category weights are totaled. So, you 
can assign points possible on Extra Credit assignments, if you use category weights to calculate 
grades. 

Weights selected for the Extra Credit category determine how much the extra credit assignments 
will contribute to term grades, in relation to other categories. If you choose a weight of 10 for Extra 
Credit, and the total of the weights of your other categories is 100, any student with a perfect score 
on every assignment would earn a grade of 110% for the term. However, AccelTest sets a top limit 
of 100%.

The following detailed example shows calculations for grades when using Category Weights with 
Extra Credit assignments:

Tests Chapter 1 Test 82/100

Chapter 2 Test 80/100

Chapter 3 Test 78/100

Total 240/300 = 80%

Homework Chapter 1 Homework 30/40

Chapter 2 Homework 20/30

Chapter 3 Homework 40/50

Total 90/120 = 75%

Field Trip Library 8/10

Museum 7/10

Total 15/20 = 75%

Extra Credit Report #1 7/10

Report #2 3/10

Total 10/20 = 50%

Tests 80% correct x 50 weight = 40.0%

Homework 75% correct x 30 weight = 22.5%

Field Trips 75% correct x 20 weight = 15.0%

Extra Credit 50% correct x 10 weight =   5.0%
Total    x 100 weight = 82.5%



Introduction and Contents

92

In
tr

o
d

u
ct

io
n

&
 C

o
n

te
n

ts

Without Extra Credit assignments, this student would have a grade of 77.5% for the term. Note 
that the Extra Credit category is not included when the category weights are totaled, making the 
assignments truly extra credit.
Note: If Drop Worst Score is checked, then an Extra Credit assignment that happens to be the 
lowest score will not contribute to the grade.
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A

AccelTest Password, 5
Add Item, 74
Add new students to section, 34
Answer Key report, 46
Assign to Students, 23
Assignment

3-digit number, 69
Assignment Analysis report, 46
Assignment Bank, 15

using, 63
Assignment Bank report, 47
Assignment Category, 15
Assignment Creation, 3

setting preferences, 58
Assignment Creation Options, 58

Default Fonts, 59
Essay, 62
Fill in the Blank, 62
Matching, 60
Modified True/False, 61
Multiple Choice, 59
Numeric Response, 61
Ranking, 61
Short Answer, 62
True/False, 60
Yes/No, 60

Assignment Editor
how to use, 74

Assignment Item
importing graphics, 78

Assignment Properties, 41
Assignment Results Report, 47
Assignment Scoring, 4
Assignment tab, 20
Assignments

add to gradebook, 21
exporting, 84
importing, 83
printing for students, 82
removing or clearing, 24

Assisted Response Items, 15, 64

C

Calendar, 10
Capacity Limit

student, 36
Category preference, 9, 51
Category Weights, 90
Change Password, 52
Check Spelling, 80
Classroom Responder

Students using, 17
Clearing Assignments, 24

D

Database
importing students, 36

Delete Item, 77
Delete Section, 41
Delete Student, 35
Delete Student from Section, 35
Deleting Students, 40
Determining Grades, 89
Dictionary, 81
Due Date, 22

E

Edit Item, 75
Edit Section, 40
Edit Student, 35
Editing Scores at the Keyboard, 28
Entering Scores at the Keyboard, 27
Errors

correcting answer key, 69
Exams Preference

setting, 13
Existing Assignments, 66
Export Results, 42
Exporting

student and grade data as text, 39
Exporting Assignments, 84
Extra Credit, 90

F

File
CSV formatted, 36
FMD formatted, 36
RBD formatted, 36

Final Grade, 13
Free Response
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grading worksheet, 30
Free Response Grading Worksheet report, 47
Free Response Item, 15, 64
Free Response Items

scoring, 30

G

Give Assignments, 21
Gradebook, 20

using, 21
Gradebook Details, 22
Gradebook Functionality, 4
Gradebook report, 48
Grading Scale Options, 4
Grading Scale preference, 9
Grading Scales

setting, 12
Graphics Files

importing, 78
Group Assignment report, 48

I

Import Students, 36
Importing Graphics Files, 78
Individual Students

give assignments, 23
Item

cancelling or saving changes, 75
delete, 77

Item (question) Types, 15
Item Point Value

changing, 76
Item Points

show and hide, 78
Item Types

matching or ranking, 65

L

Location
student FMD file, 37

M

More Information
email, 5

N

New Assignment
creating, 64

New Section, 39
New Students, 34

giving assignments to, 24
Number of Items

new assignment, 66

O

Options tab, 78
Overdue Assignments report, 48

P

Password
changing, 52

Points Only Assignment, 73
Points Per Item, 66
Points Possible, 90
Preferences, 50
Print Student Assignment, 82
Print/Preview, 56
Program Information report, 49
Properties

assignment, 77

Q

Quick Assignment, 63
QuickTime, 78

R

Registration, 8
Remove Assignment, 41
Report Descriptions, 43
Report Details, 45
Report Filters, 45
Reports, 43

S

Save Assignment dialog box, 72
Scan Answer Key, 68
School Year
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setting up, 10
School Year Information

entering, 9
Score, 16
Score Items dialog box, 28
Score Key, 16

editing by teacher, 70
Section, 9, 39
Section drop-down, 45
Select Assignment Variation dialog box, 27
Semester Grade, 13
Serial Number, 8
Show Entire School Year, 42
Show Scores as Percentages, 42
Show Scores as Points, 42
Show Term, 42
Shuffle

drop-down menu, 76
enable and disable, 78

Sort Order
assignment bank, 56
group assignment, 57

Starting AccelTest, 7
Student

delete, 35
edit information, 35

Student Assignments
teacher scoring, 30

Student Data
importing, 36

Student Grade report, 49
Student Identification Number, 4
Student Record report, 49
Students

give assignments to, 21
Subject

add, 11
Subject drop-down, 45
Subjects, 15
Subjects List

editing, 11
Subjects preference, 9
System requirements, 6

T

Technical Support
email, 5

Term Grade, 13
Text

enter and edit, 75
To-do list for teachers, 9

U

Unlock AccelTest, 16
Using AccelScan

assisted response and free response items, 30
student instructions, 19
teacher instructions, 32

V

Validate, 81
Validation Error Message, 82
Variation

answer key, 46
Variations, 59, 78
View Assignment Points per Item, 25, 27

W

Window, 62
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